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Custom Emoticons
Applies to: Cisco Jabber for Windows

You can add custom emoticons to Cisco Jabber for Windows by creating emoticon definitions in an XML
file and saving it to the file system.

To achieve optimal results, your custom emoticons should conform to the following guidelines:Note

• Dimensions: 17 x 17 pixels

• Transparent background

• PNG file format

• RGB colors

Procedure

Step 1 Create a file named emoticonDefs.xml with any text editor.
Step 2 Specify the emoticon definitions as appropriate in emoticonDefs.xml.

See Emoticon Definitions for more information on the structure and available parameters for
emoticonDefs.xml.
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Step 3 Save and close emoticonDefs.xml.
Step 4 Save emoticonDefs.xml in the appropriate directory on the file system.

Cisco Jabber for Windows loads emoticon definitions from the following directories on the file system.

• The directory can differ depending on your operating system

◦For 32-bit operating systems:

◦Program Files\Cisco Systems\Cisco Jabber\Emoticons

◦Program Files\Cisco Systems\Cisco Jabber\CustomEmoticons

◦For 64-bit operating systems:

◦Program Files(x86)\Cisco Systems\Cisco Jabber\Emoticons

◦Program Files(x86)\Cisco Systems\Cisco Jabber\CustomEmoticons

The Emoticons folder contains the default emoticons for Cisco Jabber for Windows and the default
emoticonDefs.xml.

The CustomEmoticons folder does not exist by default. Administrators can create this folder to
contain custom emoticon definitions to include in organizational deployments.

Emoticons that you define in the CustomEmoticons folder take precedence over emoticon definitions
in the default Emoticons folder.

• %USERPROFILE%\AppData\Roaming\Cisco\Unified
Communications\Jabber\CSF\CustomEmoticons

This folder contains custom emoticon definitions for individual instances of Cisco Jabber for Windows.

Emoticons that you define in this directory take precedence over emoticon definitions in the
CustomEmoticons folder in the installation directory.

Step 5 Restart Cisco Jabber for Windows.

Cisco Jabber for Windows loads the custom emoticon definitions in emoticonDefs.xml.

Custom emoticon definitions are available to users only if they are defined locally in
emoticonDefs.xml. If you send custom emoticons to users who do not have the same emoticon
definitions, those users receive the default keys, not the icons; for example:

Remember

1 User A defines a custom emoticon in emoticonDefs.xml.

The custom emoticon definition exists only on User A's local file system.

2 User A sends that custom emoticon to User B.

3 User B receives only the default key for the custom emoticon. User B does not receive the icon.

   Features and Options for Cisco Jabber 11.5
2

Cisco Jabber for Windows Features
Custom Emoticons



Emoticon Definitions
Cisco Jabber for Windows loads emoticon definitions from emoticonDefs.xml.

The following XML snippet shows the basic structure for the emoticon definitions file:
<emoticons>
<emoticon defaultKey="" image="" text="" order="" hidden="">
<alt></alt>
</emoticon>
</emoticons>

The following table describes the elements and attributes for defining custom emoticons:
DescriptionElement or attribute

This element contains all emoticon definitions.emoticons

This element contains the definition of an emoticon.emoticon

This attribute defines the default key combination that renders the
emoticon.

Specify any key combination as the value.

This attribute is required.

defaultKey is an attribute of the emoticon element.

defaultKey

This attribute specifies the filename of the emoticon image.

Specify the filename of the emoticon as the value. The emoticon image
must exist in the same directory as emoticonDefs.xml.

This attribute is required.

Cisco Jabber for Windows supports any icon that Internet Explorer can
render, including .jpeg, .png, and .gif.

image is an attribute of the emoticon element.

image

This attribute defines the descriptive text that displays in the Insert
emoticon dialog box.

Specify any string of unicode characters.

This attribute is optional.

text is an attribute of the emoticon element.

text

This attribute defines the order in which emoticons display in the Insert
emoticon dialog box.

Specify an ordinal number beginning from 1 as the value.

order is an attribute of the emoticon element.

This attribute is required. However, if the value of hidden is true this
parameter does not take effect.

order
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DescriptionElement or attribute

This attribute specifies whether the emoticon displays in the Insert
emoticon dialog box.

Specify one of the following as the value:

true

Specifies the emoticon does not display in the Insert emoticon
dialog box. Users must enter the key combination to render the
emoticon.

false

Specifies the emoticon displays in the Insert emoticon dialog box.
Users can select the emoticon from the Insert emoticon dialog
box or enter the key combination to render the emoticon. This is
the default value.

This attribute is optional.

hidden is an attribute of the emoticon element.

hidden

This element enables you to map key combinations to emoticons.

Specify any key combination as the value.

For example, if the value of defaultKey is :), you can specify :-) as the
value of alt so that both key combinations render the same emoticon.

This element is optional.

alt

The default emoticons definitions file contains the following key combinations that enable users to request
calls from other users:

Remember

• :callme

• :telephone

These key combinations send the callme emoticon, or communicon. Users who receive this emoticon can
click the icon to initiate an audio call. You should include these key combinations in any custom emoticons
definition file to enable the callme emoticon.

Emoticon Definition Example
<emoticons>
<emoticon defaultKey=":)" image="Emoticons_Smiling.png" text="Smile" order="1">
<alt>:-)</alt>
<alt>^_^</alt>
</emoticon>
<emoticon defaultKey=":(" image="Emoticons_Frowning.png" text="Frown" order="2">
<alt>:-(</alt>
</emoticon>
</emoticons>
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Browser Click to Call
Applies to: Cisco Jabber for Windows

With Browser Click to Call, users can start a call from any of the following browsers:

• Internet Explorer, from version 9

• Mozilla Firefox, from version 38.0a1

• Google Chrome, from version 45

Users can highlight and right-click on any number, URI, or alphanumerical string and choose one of the
following options:

• Call—Spaces and punctuation are stripped and the call is started.

• Call with Edit—Spaces and punctuation are stripped and the number is displayed in the Search box of
the hub window. Users can edit the number before starting the call.

Browser Click to Call is enabledwith the CLICK2X installation parameter. If this parameter is set to ENABLED
(default value), the feature is enabled. To disable this feature, you must set the CLICK2X installation parameter
to DISABLE. For more information about the CLICK2X parameter, see the Deployment Guide for your
release.

Click to Call from Google Chrome
Click to Call from the Google Chrome browser requires user input before it can be enabled. After users install
and sign into Cisco Jabber, they must restart the Google Chrome browser. When the browser opens, a popup
displays requesting users to allow installation of the “Jabber Call” extension. Users must allow the installation
by clicking Enable Extension. The extension is installed and users can now make calls by highlighting and
right-clicking on any phone number that is displayed in the browser.

If users do not have administrator privleges for their machine, they do not receive the popup requesting them
to allow installation of the “Jabber Call” extension. In this case, users must contact their system administrator
to install the extension.

Click to Call from Mozilla Firefox
Click to Call from the Mozilla Firefox browser requires user input before it can be enabled. After users install
Cisco Jabber, they must restart the Firefox browser. When the browser opens, a popup displays requesting
users to allow installation of the “JabberCallAddOn” add-on. Users must allow the installation by clicking
Allow this installation and Continue. The add-on is installed and users can now make calls by highlighting
and right-clicking on any phone number that is displayed in the browser.

Click to Call from Internet Explorer
Click to Call from the Internet Explorer browser does not require any user permissions or installations.
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Problem Reporting
Applies to: Cisco Jabber for Windows

Setting up problem reporting enables users to send a summary of issues that they encounter with the client.
There are two methods for submitting problem reports as follows:

• Users submit the problem report directly through the client interface.

• Users save the problem report locally and then upload it at a later time.

The client uses an HTTP POST method to submit problem reports. Create a custom script to accept the POST
request and specify the URL of the script on your HTTP server as a configuration parameter. Because users
can save problem reports locally, you should also create an HTML page with a form to enable users to upload
problem reports.

Before You Begin

Complete the following steps to prepare your environment:

1 Install and configure an HTTP server.
2 Create a custom script to accept the HTTP POST request.
3 Create an HTML page that enables users to upload problem reports that are saved locally. Your HTML

page should contain a form that accepts the problem report saved as a .ZIP archive and contains an action
to post the problem report using your custom script.

The following is an example form that accepts problem reports:
<form name="uploadPrt" action="http://server_name.com/scripts/UploadPrt.php" method="post"
enctype="multipart/form-data">
<input type="file" name="zipFileName" id="zipFileName" /><br />
<input type="submit" name="submitBtn" id="submitBtn" value="Upload File" />
</form>

Procedure

Step 1 Host your custom script on your HTTP server.
Step 2 Specify the URL of your script as the value of the PrtLogServerUrl parameter in your configuration file.

My Jabber Chats and My Jabber Files Directory Location
Applies to: Cisco Jabber for Windows

If instant messages and file transfers are automatically saved each time a user closes a conversation (with the
EnableAutosave parameter), the default location for these files is the Documents folder. Chats are saved in a
folder called MyJabberChats and files are saved in a folder called MyJabberFiles.

However, you can specify a different location with the AutosaveChatsLocation parameter or let users choose
their own location with the AllowUserSelectChatsFileDirectory parameter. If users are allowed to set their
own directory location, then the user setting takes priority over the system-defined setting. For more information
about these parameters, see the Parameters Reference Guide for your release.
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IBM Notes Contact Search and Calendar Integration
Applies to: Cisco Jabber for Windows

Cisco Jabber for Windows supports IBM Notes calendar integration in the Meetings tab of the client. Cisco
Jabber also lets users search for and add local contacts from IBM Notes. To enable this integration with IBM
Notes, you must set the following parameters:

• EnableLocalAddressBookSearch=true

• EnableLotusNotesContactResolution=true

• CalendarIntegrationType=2

The CalendarIntegrationType parameter can be overridden by users. To enable calendar integration and contact
resolution with IBM Notes, users must ensure that the Calendar integration type on the Calendar tab of the
Options window is set to IBM Notes.

In order for users to be able to successfully add IBM Notes contacts to their contact lists, the Messaging
ID field in IBM Notes must contain a valid value.

Note

Contact Resolution for Incoming Calls

For incoming calls, Cisco Jabber for Windows does not search the address book in IBMNotes, therefore only
the phone number for an IBM Notes contact shows in the call history. If Cisco Jabber users subsequently
search for the contact associated with the phone number, the call history changes to show the contact's name
instead of the phone number.

Integration with Microsoft Products
Applies to: Cisco Jabber for Desktop Clients

Cisco Jabber for Windows supports a range of Microsoft products that integrate with the application. This
section describes the support and integrations for these products.

Internet Explorer

Microsoft Internet Explorer 8 or later is required. Cisco Jabber for Windows uses the Internet Explorer
rendering engine to display HTML content.

Cisco Jabber for Windows requires Internet Explorer active scripting to render IMs. See https://
windows.microsoft.com/en-US/windows/help/genuine/ie-active-script for instructions on enabling active
scripting.

Internet Explorer 9 users in Cloud-based deployments that use Single Sign On (SSO) get security alerts
when they sign in to Cisco Jabber for Windows. Add webexconnect.com to the list of websites in the
Compatibility View Settings window of Internet Explorer 9 to stop these alerts.

Note
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Office

Integration with the following versions of Office is supported:

• Microsoft Office 2016, 32 and 64 bit

• Microsoft Office 2013, 32 and 64 bit

• Microsoft Office 2010, 32 and 64 bit

Office 365

Microsoft Office 365 supports different configuration types based on the plan or subscription type. Cisco
Jabber for Windows has been tested with small business plan P1 of Microsoft Office 365. This plan requires
an on-premises Active Directory server.

Client-side integration with Microsoft Office 365 is supported with the following applications:

• Microsoft Office 2016, 32 bit and 64 bit

• Microsoft Office 2013, 32 bit and 64 bit

• Microsoft Office 2010, 32 bit and 64 bit

• Microsoft SharePoint 2010

SharePoint

Integration with the following versions of SharePoint is supported:

• Microsoft SharePoint 2013

• Microsoft SharePoint 2010

Availability status in Microsoft SharePoint sites is supported only if users access those sites with Microsoft
Internet Explorer. You should add theMicrosoft SharePoint site to the list of trusted sites in Microsoft Internet
Explorer.

Calendar Integration
You can use the following client applications for calendar integration:

• Microsoft Outlook 2016, 32 bit and 64 bit

• Microsoft Outlook 2013, 32 bit and 64 bit

• Microsoft Outlook 2010, 32 bit and 64 bit

• IBM Lotus Notes 9, 32 bit

• IBM Lotus Notes 8.5.3, 32 bit

• IBM Lotus Notes 8.5.2, 32 bit

• IBM Lotus Notes 8.5.1, 32 bit

• Google Calendar
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Microsoft Outlook Calendar Events
Applies to: Cisco Jabber for Windows

You must apply a setting in Microsoft Outlook so that calendar events display in Cisco Jabber for Windows.

Procedure

Step 1 Open the email account settings in Microsoft Outlook, as in the following example:
a) Select File > Account Settings.
b) Select the Email tab on the Account Settings window.

Step 2 Double-click the server name.
In most cases, the server name isMicrosoft Exchange.

Step 3 Select the Use Cached Exchange Mode checkbox.
Step 4 Apply the setting and then restart Microsoft Outlook.

When users create calendar events in Microsoft Outlook, those events display in theMeetings tab.

Microsoft Outlook Presence Integration
Applies to: Cisco Jabber for Desktop Clients

To enable integration with Microsoft Outlook, you must specify SIP:user@cupdomain as the value of
the proxyAddresses attribute inMicrosoft Active Directory. Users can then share availability inMicrosoft
Outlook.

Use one of the following methods to modify the proxyAddresses attribute:

• An Active Directory administrative tool such as Active Directory User and Computers

The Active Directory User and Computers administrative tool allows you to edit attributes on Microsoft
Windows Server 2008 or later.

• ADSchemaWizard.exe utility

The ADSchemaWizard.exe utility is available in the Cisco Jabber administration package. This utility
generates an LDIF file that modifies your directory to add the proxyAddresses attribute to each
user with the following value: SIP:user@cupdomain.

You should use the ADSchemaWizard.exe utility on servers that do not support the edit attribute feature
in the Active Directory User and Computers administrative tool. You can use a tool such as ADSI Edit
to verify the changes that you apply with the ADSchemaWizard.exe utility.

The ADSchemaWizard.exe utility requires Microsoft .NET Framework version 3.5 or later.

• Create a script with Microsoft Windows PowerShell

Refer to the appropriate Microsoft documentation for creating a script to enable presence in Microsoft
Outlook.
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Enable Presence with the Active Directory User and Computers Tool
Complete the following steps to enable presence in Microsoft Outlook for individual users with the Active
Directory User and Computers administrative tool:

Procedure

Step 1 Start the Active Directory User and Computers administrative tool.
You must have administrator permissions to run the Active Directory User and Computers administrative
tool.

Step 2 Select View in the menu bar and then select the Advanced Features option from the drop-down list.
Step 3 Navigate to the appropriate user in the Active Directory User and Computers administrative tool.
Step 4 Double click the user to open the Properties dialog box.
Step 5 Select the Attribute Editor tab.
Step 6 Locate and select the proxyAddresses attribute in the Attributes list box.
Step 7 Select Edit to open theMulti-valued String Editor dialog box.
Step 8 In the Value to add text box, specify the following value: SIP:user@cupdomain.

For example, SIP:msmith@cisco.com.

Where the user@cupdomain value is the user's instant messaging address. cupdomain corresponds to
the domain for Cisco Unified Presence or Cisco Unified Communications Manager IM and Presence Service.

Add Local Contacts from Microsoft Outlook
Cisco Jabber for Windows lets users search for and add local contacts in Microsoft Outlook.

All local contacts in Microsoft Outlook must have instant message addresses and phone numbers. These
details allow client users to do the following:

• add local Microsoft Outlook contact to their contact lists

• see contact photos from the client

• send instant messages to local contacts

• call local contacts from the client

Administrator Tasks

To enable this integration with Microsoft Outlook, you must enable Cached ExchangeMode on the Microsoft
Exchange server.

To allow users to search for local contacts in Microsoft Outlook from the client, users must have profiles set
in Microsoft Outlook.

User Tasks

Users must set the correct calendar preference on the client.
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1 Select File > Options.

2 Select the Calendar tab.

3 SelectMicrosoft Outlook.

4 Restart Cisco Jabber to apply the change.

Chat History in Microsoft Outlook
Applies to: Cisco Jabber for Windows

This feature is available in the following versions of the client:
Supported ServersVersion of Cisco Jabber for

Windows

Microsoft Exchange 2013

Microsoft Exchange 2010

10.6

Microsoft Office 365

Microsoft Exchange 2013

Microsoft Exchange 2010

11.0

You can enable the client to automatically save chat histories to a Cisco Jabber Chats folder in the user's
Microsoft Outlook application. When a user closes a chat window, the client saves the IM conversation to
the Exchange server.

To enable the feature, you must:

1 Set the EnableSaveChatHistoryToExchange parameter to true in the jabber-config.xml file.

2 (optional) Set up amethod to authenticate users to the Exchange server. If you don't specify an authentication
method, then users can authenticate directly from the Outlook tab in the Options menu of their clients.

3 Specify the method for determining which server to use.

For more information about all of the parameters that are needed to enable this feature, see the Parameters
Reference Guide.

Limitations for Saving Chat History to an Outlook Folder
This feature can only be enabled if users have a Cisco Unified Communications Manager account.

Limitations with Authentication Methods over Cisco Expressway for Mobile and Remote Access

If you are enabling this feature for users connecting via the Expressway for Mobile and Remote Access, the
following limitations apply:

• If the client detects that the user is connecting via the Expressway, then the client uses the External
Server option for the Exchange connection. If the external server is not set, then it uses the internal
server.
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• If the client detects that the user is not connecting via the Expressway, then the client uses the Internal
Server option for the Exchange connection. If the internal server is not set, the client uses the external
server.

• However, if either the internal or external server is set, but for some reason Cisco Jabber can't connect
to it, the client doesn't revert to using the other server.

Authentication Modes
You must set up a method of authentication for the client to authenticate with the Exchange server. When
authentication is complete, the client has access to the Exchange server which allows saving chat histories to
a folder in Outlook.

If you do not specify an authentication method, then users must manually input their Exchange credentials in
the Outlook tab in the client.

Authenticate Using Single Sign On for the Operating System

Applies to Cisco Jabber for Windows only.

The client uses the account details of the logged in user to authenticate with the Exchange server. This
authentication method uses the Windows NT Lan Manager (NTLM) security protocol.

Do not use this authentication method if some users share the same Windows account. The client
authenticates with the account on the Operating System, and not with the user who is logged in to Cisco
Jabber. For example, User A logs onto a Windows machine and then logs into Cisco Jabber for a morning
shift. When the shift is done, Jabber is reset and User B logs into the client for the afternoon shift. Because
User A is logged into the Windows account, then the chat messages from User B are saved in the Outlook
account for User A.

Note

Before You Begin

Users and their computers must use domains. Authentication using single sign on does not work if users are
local Windows users.

Procedure

In the jabber-config.xml file, set the ExchangeAuthenticateWithSystemAccount parameter to true.

Authenticate by Synching Credentials

You can sync the Exchange credentials with another set of credentials for users, such as the Cisco Unified
Communications Manager IM and Presence credentials. Using this method, the client uses the credentials to
authenticate to the Exchange server.
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Procedure

Step 1 In the jabber-config.xml file, configure the Exchange_UseCredentialsFrom parameter.
Step 2 Define the value of the parameter as the service that you want used to sync credentials. For example,

<Exchange_UseCredentialsFrom>CUCM</Exchange_UseCredentialsFrom>.
In this example, Cisco Unified CommunicationsManager is defined as the service which provides the Exchange
server with credentials for authentication.

Specify Server Addresses
After you enable an authentication method for the client to access the Exchange server, you must enable a
method for the client to specify the Exchange server address.

If you do not specify server addresses, then users must manually enter the internal and external Exchange
servers in the client, in the Outlook > Advanced tab of the Options menu.

Detect Server Addresses Automatically

Applies to Cisco Jabber for Windows only.

You can configure the client to automatically discover the Exchange servers based on users' domain. This
domain is defined when you set up the authentication method by using the domain that was specified for the
user's credentials.

Procedure

Step 1 In the jabber-config.xml file, configure the ExchangeAutodiscoverDomain parameter.
Step 2 Define the value of the parameter as the domain to discover the Exchange server.

The client uses the domain to search for the Exchange server at one of the following Web addresses:
https://<domain>/autodiscover/autodiscover.svc

https://autodiscover.<domain>/autodiscover/autodiscover.svc

Define Server Addresses

You can define the internal and external Exchange server addresses in the configuration file.

Procedure

Step 1 In the jabber-config.xml file, configure the InternalExchangeServer and ExternalExchangeServer
parameters.

Step 2 Define the value of the parameters using the Exchange server addresses.
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